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�����  
 ��� 	
 �����2000ــــــ�ت ���� ��ل ا��و

## ���������# ا�"!� إ�� ا������  : 

آ� أ9!ء �4���7 و��. ��45 
�2آت #,� �2��3;
2
�$ B'�? ا�	#� إ�= ا�@2%�? <�= + �	ا-> �  C�Dا�
4�1 E!0 ا�E C�D� ا��	E ر	F@ا�� ا�@2%�? /. ا� .....��� : وذ�G آ

 .ا/�B M'�? -0#0ة  -1
2- ����% O3P2 ا�Qن /. ا�7'�? وا�

� ا�[\�?  Page Properties ا�'Tرة /. أي . 
3- �#	Dا�� ?
_E =1E O3P1= اE`ا �
 Language . 
ر ا`ول 1E= ا�@2%�?  ا-@� -4�dا� + Gا(� دو��. 
5- .hFر ا��dا-@� ا� C�Fوا� Arabic . 
6- O3Pا OK  ?�'7�9 ا%0أ ا�@�� /. ا�.  

  
## ��  : ) ا
��4#ي -,��+ ( �0/ ا�"!� �-.�� ,-� آ'��� 
( ,��+ أو 
( �)'�&  آ�

(r!1� ?D ا����	ب 
� ا��5ر2000ا�'2وo�% ph  #'�2ض!
 4hأ  Lift" ����1�  أي B'�? -0#0ة �[	م %'��4
To Right" ا �
 �1@� 5�1ر وا�!r ا�@2%. آ�� ����� ..!�1E �,# إ�= ��ا r!ا� x Right To" ��	#� ا�,

Lift" ?��رات ا���d0 ا�>T% Gوذ� : 
1- �

� �html dir=rtl> . �5> إ�= <html> �2��3 و(� %0ا#? ا�7'�?  Gوذ� HTML  phأ('� ا�'2و ./
 o�%2000ا�0رس ا`ول ./ h2ذآ  .  آ�

�أو �2��3 و(� %0ا#? 
!�[? ا�,�5  -2 <body> =إ� <body dir=rtl> . 
* ?�>_
 : [ �
ل �O#2 ا���2#2 ا�2أ(. ]�hا �>_�) ��]%ر#� ا�5�d0  /. ا�!E را����� إ�= ا��5

M'7أو /. ا��� o�% phا�7'�? /. ا�'2و ?!#@
 ] . 
3- x ا����	ب ا�!r إ�= ا�@2%�? /. ا�!r أو %(�0dام ا�,0اول ��!��� ا�G!��# C�> ، ?�'7 �2��3 ا�,


� دا�Q ا�,0ول /[O ، وذ�G %�2��3 و(� %0ا#? ا�,0ول <table> =إ� <table dir=rtl> . 

� أو �2��3 -4 ?�1d2��3 و(� %0ا#? ا��% Gا�,0ول ، وذ� #_Q �
 O]/ �1? وا<0ةQ <td> =إ� <td dir=rtl> . 


� ا�7'�? 
� ا������� r!ا� x5�1ر و�2#0 وه�ا (�'�0ك إذا آن ا�,� #_Q 0>�1$ي /. أ,hا rh �&� أن 
 ، <�C أنً���!� 2F�1? ا�,0ول و-@1> أآd-@� و(� %0ا#? ا� 	ه G�1E 
 . <td dir=ltr> آ� 

5- �
 ، <p dir=rtl> إ�= <p> أو �2��3 ا�,x ا�!r ��[�� أو /[2ة 
�0دة وذ�G %�2��3 و(� %0ا#? ا�'[2ة 

� ا��5ر ����1� ا� rh ��5!� ./ (�'�0ك 	وه�%
�F ا�!r ا+h,�1$ي %��MD7# C و(� %0ا#?  5 x2ذآ

 . <p dir=rtl> و��� <p dir=ltr> ا�!r ا+h,�1$ي /. 2E ?�'B%�? ه	
�ـــــ?  ***>_
] : ?%   . [ dir ��آ2 دا\�ً ا��5/? ��D آ�

  
## )
   :آ�� :+ ��>�و;�:	 وورد  67& 

?#4h OD&� ب /. /[2ة وا<0ة	��
 ��@
 rh 2�)أ ���-�
أ<0 ا`وا
2  إ�= <p>  ، ��2 و(� %0ا#? ا�'[2ة 
 ?��  :ا��

1- <P dir="rtl" style="TEXT-ALIGN: justify"> . 
 2- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: inter-word"> . 
 3- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: newspaper"> .  
4- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: kashida"> .  

 
## ��=�>  ��� 	
    :2000وB7 ,�ة ار��6<�ت :+ �Aرة وا��ة ��ا;?� ا��و

 ./. ا�7'�?  أدرج ا�7	رة -1
�24 /. ا`('� �O#2 أدوات ا�7	رة... أ�1E 2= ا�7	رة %�'Tرة  -2�) . 
3-  ?9_9 O#2;ل ه.(�,0 /. ا�4 واB!� ��� <	ل أي -$ء 
�  أ��!
 0#2� 
 O3Pا

ط Dار� MD7# أن x0#2� رة	ا�7. 
ط -4Dا+ر� �Pار و	2%� <
 M�'�) رة	ا�;�� /. ا�7 �P0 أن ���� و@% Create Hyberlink ،  طDا+ر� �P

O3Pا��ي �2#0 وا OK .   

  



 3 

## )
 B7�� /C� +"
  : ار��6ط 
"+ ، =�F� ,-� ��ور ا�Eرة ,�� �Aرة أو ,�� ار��6ط 

�24  )أ# rh 0!E �#0% r!0م آd�5# 	رة ، وه	1= ا�7E 0 ا��2ور!E  
0Eم ¡4	ر ا�7	رة أو �1;2ح <	ل 
 .���  :�04ف إ��> ا�7	رة ، و#�� 1�E> آ

 .ا�7	رة /. ا�7'�?  أدرج -1
2- �
 2�Qرة واT'ا� �رة %���	1= ا�7E O3Pا ?�\ . Picture Properties ا�[
3- ?hQ ./ اآ�� Text r!ا� O3Pا��ي �2#0 �9 ا OK . 
ط 7h.  -بD1= ار�E رةT'2ور ا�
 0!E rh:  
 . ¡1E �1= ا�!r ا���1	ب -1
2- �5� M�/ا HTML  o�% ph2000/. أ('� ا�'2و.  
3-  ?��4 ا�;'2ة ا��� ¤P11? ، أ�
 r!�4ا ا�% ?Bd0 ا�;'2ة ا�,�):   

title=""�P ا�!r ه!
ل F
: ط ه	 D1. ��4ا ا+ر�B`د ا	ن ا��إذا آ

<p><a href="http://www.des4arab.com/index.htm">?�'7ا�2\��5? ا�</a></p>
MD7�) ?/P¦د %@0 ا	ن ا��§/ 

<p><a href="http://www.des4arab.com/index.htm" title="r!ا� �P "ا�7'�? <ه!
<a></p/>ا�2\��5?

���رب ##�?;I�6,� ا� :,J ��=.���6 أو �� =����   و

 o�% phا(�? /2و	ذج2000%0Eاً   #��!G -@� ا`(�2 أو ا�7	ر أو ا�!�D� أو  ا�,0اول أآ2F أو أ�� �[ر%ً#_Q أو
 4�1# 
4 أو ]D5# 
 �E...  .��� :وذ�G آ

1- ?�\� M�/ا Format 2�Qوا Paragraph . 

2%� <	ار -2 M�'�) Paragraph ... ?hQ �
 Spacing �#0@� G!��#  أن C�> 0EDرب أو ا�� :ا��[

 Before : <]D5# )أ ?/5
ص 2��3�% Q . 


 After : <�1# )ب ?/5
ص 2��3�% Q .  
  

##  ��� 	
�L إ�� ��L�M :+ ا�6K>� ��ا;?� :�و�!A /�
2000:   


� ا(�0dام ا��� +ً0% o�% phا(�? /2و	% G��'B 2;h G!��#M'7 o
h2% أو ftp  .��� :وذ�G آ
1- ?�\� M�/ا File O3P1= واE Publish Web . 
آ�� أ#& ا(� ه�ا  اآ�� /. ا`E =1E!	ان -2/ ��@

ً_ ، وإن اردت ار(ل ا�7'�ت ��,01 
	�@G آ

�F
 . http://www.des4arab.com/HTML ا��,01 
 .ا`('�  /. Publish اO3P زر -3
4- ، �%2
 M�'�)?�10م وآd�5اآ�� /�> ا(� ا��  O3P�9 ا G@�	�% ?Bdا��2ور ا� OK .   

  
  :�6�=�ك  �'!�=� ,-�ان ا��;��� ,-� 7�& ا�#اN� ,�� ار��6ط

ط �2D#0ك  -1Dار� x0#2� ا��ي r!�1 ا�¡.. �F
 "  . "ا��7 %!
ط -2Dء ا+ر�;hار إ	2%� <
 M�/ا " Create Hyperlink" . 
3- ?hQ ./ URL اناآ�� ا	!Eان %2#0ك و	!E 2��3� �
 ، .���  ?�  :ا�2(
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 اIول ا��رس

 
 

 ������ ه� ه� ���
  ��� ا��ء �
 :أو� ��� � !� �"��� # $���"! # - )'ا�& - -)  
 . إ�-.. +*�
  ا�9ز�7 �$�6 # 45�*ت ا���2 ؟ �*ه
 ا��'ا�& :(*0 ً* 

وز  : ( Notepad ) ا�$4;'ة -1E��( 7+��'... وه
 ���Hدة �$F ا��'ا�& ا�$!'�6� *Iا��6J6# ا�ا���Eص ا�6
  و
 & ( L0ا�4'و 
� *I+و�� *I�M0 #) Fو� �"��� 
� *I"N6J. 

2-  & ( L0و'� L��Jو';�*�2000 (FrontPage): L��J7 � ;'و!U*� F� �0V W*0'6Xا وه� ����ع �'EZ* ، و�

�6ا��  أو� \ ا�6Jا F� �IM J وه[ا *Iا��6Jا ^!� *��'+�أن ��$#  وه� )'0*�& ��ي �6M` _. ا�6*د ا�;� 

 �6`Jا�( 
 ه[ا ا��'d� F$� &�*0$��7 أو� \ . 45�*ت )$�6Mى ا6Z'ا�H��وه� g ' ( آ$* ذآ'0*  2000و
 ) .�ّ"'ب 

3-  
��J0*�& ر'(:  F�7 �!�4�7 آ*��!4 *ت وا�"E*و �*$H ت*M$� 7�*�k .. -إ� .W]ه Fو�  
!� :ا��'ا�& �* 
����ب *��) Photo Shop( 

 LE ( (Paint Shop Pro) ��ب *
 (Flash) �9ش *

وز *E��( s�'$م ا�*J'ا�  
�6ا��Jا  d� 'Xu 
��Jأو أي )'0*�& ر . 

 . [W ا��'ا�& �
 ا�$��_ )$} 7z اyوJ ;�ن هE*ك دروس ��"v ه

 
# 	
�ّ��ف ,�� وا��0 :�و  ���2000:  


o وأدوا�> h	رد ه�x ا��@1	
? E� B'�? ا�	#� و��� ��D ا�0Dء /. �2ح ر
	زh2Dا�  
* ?�'B 0أD� html �)	� . <html/> و�!�4. %ـ�	(� <html> أو ا¦�¬ �. ام ال %ـ
 �![�5 ا�7'�? إ�= 
!�[��� ه� *:  
 .و���	ي E =1E!	ان ا�head>  ?�'7/> و�!�4. %ـ�	(� <head> و�0Dأ %ـ�	(� :ا�0�4 
!�[? ا�2أس أو -1
�24 /. ا�body> ..  ?�'7/> و <body> و�[� %�� ا�	(��� :ا�D	دي 
!�[? ا�,�5 أو -2�) 
وآ� 

xد /. ه�	-	
 .ا��!�[?  (��	ن 
o�% phا�'2و M�/1= ، (�,0 أن ا¦®2000وان اE ي	��# o
h2Dر أ('� ا� / Normal 9_ث �5م ه. 

HTML / Preview . 
  : Normal ا�[�5 *!>2�  .ه	 
!�[? ا�@�� ا��. (��2آ$ /�4

1Q o¤ ا�HTML : ?�'7 �[�5ا *h2Dا� <D��# د ا��ي	ه0ة ا��;�� . 
�Preview : 24 ا�[�5 *�) ه0ة ا�7'�? آ�;��  M'7��1� .. ¤�&� 0 أن@% G��� ./ ?�'71� ء.�

�5� Normal ./ xر	ه0ة ®2#[? ¡4;�% �� ?]�!
 Preview . 
* Uح أه�X نYا Lإ��  ��� 	
  :2000ر��ز أX�<� أدوات :�و

 

 
  اIول ا
'�� ا��رس
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  ا�
رس ا����� 

# ��� 	
 : ا;')�ام :�و

 ������ و����� ��� وا��� ��و�� ��ع ���
 أن "
دت �
أ ا�+*(�) ا'ن2000 :  ا
د U*�X{ ا��4�7 : أوً� Z ...~ ؟ آ 

'6Xا�4*رة وا F $�
 أي �;*ن �*رغ �
 ا��4�7 ا��� � 7�ME$7 ا�$U*+ا� F� Page Properties  ة]�*Eا� �� 'I�6J
 : ا�6*� 7

 
0#2� 

? ا��D	#�اO3P /. ا` %@0 ذ�G... <0د _E =1E =1E Background ?���G� 24 ا�!/�ة ا���) : 

 
&� . OK ��د �� ��=� \U ا7

 
 ً�hت % ا%0أ 9 :2#2��%®Dا+ر� ��Eر و	ت ا�7'�? وإدراج ا�7 آ�¤ ؟.... �� ا�7'�
�9 ا%0أ ) و(O أو#��� أو 5#ر ( ا��2�² /. أي (�2 �2#0 و/. أي -�P  ?44 :¦دراج rh /. ا�7'�?  *

?%���% .  
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[ ?�>_
�&E =1E O3!0 ا���%? /. ا�'2وo�% ph وأردت : % ?]%ل �2�51 ا���. ¦آ�ل ا�,�1? ا�5]�h+ا 
Enter 2ة�Dآ ?/ [  . ( Shift+Enter ) �5	ر و��� اO3P%�� ا� (��	ن ا��5

4 Picture �9 اInsert 2�Q ا/�M ا�[\�? :¦دراج B	رة  *!
 2�Qا ?�\� M�'�) From File  رة	2 ا�7�Qا G0 ذ�@%
 . OK واO3P ا��. �2#0ه

4��5 ، �![G1 �7'�? أ2Qى أو �7	رة *� 
ط أو �!G أو <�5 D1? أو ار�Bو �P	� ` ي أو ���5!0 وورد أو
 4�1E O3&0 ا�!E ¤1
:  

ط  -1Dاآ�� ا(� ا+ر�:  _ًF
 .. ?�7d;ا� .��'B ه0ة;��" " .اO3P ه!
2-  �1¡"O3Pا  ط �G��'7 ا�;�7d? " .. ه!Dار� MD7� أن  .وه. ا�,�1? ا��. �2#0ه
3- M�/ا ?�\4 Insert ا�[!
 2�Qوا Hyperlink O3Pأو ا Ctrl+K  M���24 �.. /. �	<? ا��'�)G  ة�/ا�!

?��   ا��

 
(1) : 4�'�% p�� .ت ا���24 ا�7'��) ?>ط إ�= ه�x  .. /. ه�x ا��5Dار� ��E �45�) وه�ا

وس 1E= ا�7'�? ا��. �.. ا�7'�ت ���2ة /. " اO3P ه! " ر4�% %,�O]/0#2  ?1 أ�2 %D
و(���� 
 ?hd2(ا� (O3P�9 ا ، OK . 
(2) : �2ة 
� ا
�0ادهD
G!��# ?h آ�%? ا(� ا�7'�? dا� x/. ه� 	) وهhtm.( . 
/�ة -0#0ة : (3)h G� M�'�) $
ت -4زك  %�&1E O3= ه�ا ا�2'1
4 أن ��5@2ض 
,01ات و�_Q �
 G!��#

 pµ� 
ر ��Q1?وا�,� .ا���11? /. ا��%2��  ?�'7> %
(4) : G� M�'�) $
�&1E O3= ه�ا ا�2%  .hط إ�= %2#0 إ���2وDار� ��@� x�/h .. ./ ?1B	1= ا�E O3&0 ا�!E

M�'# M'7ان ا��. ا���	1= ا�@!E ?�
o ا�2D#0 ا¦���2وh. ا+/�2اrd;1� .P ا���G� �)2�� M'7 ر(h2% 
 .(���D> /. ه�x ا�!/�ة 

ر h	ع ا��1¤ ا��ي (��%2> %,�1? %@0 �d� أن "  . OK اO3P "اO3P ه!
ط �7'�?" اO3P ه!"(�_<� أن -�1? Dار� p�DBأ 4hأي أ OQ 4��� MDB2  أQ· ¤1�� 2ى أوQأ. 

ت /. 
	�@G  و%!'� ا��2#[? �[	م %@�� ]®D2 .. -��� ا+ر�Q· ع	h �
 . [!!-2ب ��E و1B? أ2Qى ��¤1 
ط #,� ان #��� /�>+<� أن ا+ر�** D  ¤10اد ا���

�0اد... ا+(� 
� ادة %E ن	�� o
 zip أو F�/ exeً_ ا�2Dا

�h?  ��ا #,�,
 o
ط ������  /�Fً_ �	 اردت G�1E ...��E آ�%? ه�ا ا+
�0اد اذا ر�B ��E pD'�? %2اDار�
�)% o
h2% mIRC 	ه x0اد�
�.  exe وا��ط آDن ا+ر�	ان #� �,#: ،  exe.RC mI توه��ا �D[�? ا��1'

 �Q_ف ا
�0ادا�4%. 
 

# +��!A `�E; aا���4ز ؟؟؟ آ� +: +�� و���� ��

	�@T% G<0 ا+
�0اد#� �� %�'� ا�7	ر ا��. -1 ./ 4
0d�5�) jpg أو gif . 
4 <�= +  jpg ا
�0اد <�0d�5�) Cم *hا	��1 أ�]� �D]� + .ر ا��	أو ا�7 ?�@�D2 ا��¡!�1�05'�   .د��4

o ا�G#0� �)2  /4	 �2,1ا/�G ا��. (�[	م %@�41 gif أ
 ا
�0اد *h2% ./. 
2- �
 G�'1
ت وB	ر  #,� <'� -��� �'B .. ت إ��4®Dار� ��@% �� G01 وا<0 و%@0 ذ�,
 ./ ºإ� ..

+ =�> Gوذ� ?�D;إ�= ا� 4�آ� /. ¡4	ره E!0 ار(;
   آ�¤ ؟؟؟؟ ... ��0ث 
�G /. ا��,01 ا���.#'�2ض / ]�'B ���- �'> o�% ph2و C:\mydocument\myweb .. �,# G���  G�1E

01,
 ./ 4
0d�5�) .ا�� G�'1
ط �4  myweb أن �&� -��� Dاي ار� ��E �D� .
�!D5? �71	ر  أ%
01,
 �Q01 دا,
 4� o�% ph2ض /2و�'�/ myweb 	وه images أن �&'# G��� / G�/ر وا�,2ا	ا�7 �&� 4�
 4!
 2�D0د آE <% G@�	
B? اذا آن Q .../ 4�و%@0 ذ�c:\mydocument\myweb\images  G أي (��'

طDار� 4 M��B .. آ� �@p�1 /. ا�5%�  �[	م %§درا-4 /. ا�7'�? أو �4� �!7
5ر ا(�0dا
و%��G #�	ن 
?�D;1� 4�آ� %�;�µ? ا¼ و��E 24!0 ار(;
 . [ %0ون 
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41 ا� ®#2[? <'� *�E 0@% ز :7'�? /. ا�,4
?�\ :ا����?  (�'�G� M ا�!/�ة Save واFile 2�Q ا/�M ا�[

 
?hdا� ./ File name ان ا�7'.. ا(� ا�7'�?  اآ��	!E 2��3� G!��#  /. آ�]D5
�? ا��ي <0د�> 

�
7\r ا�7'�? Q =1E O3&�% Gة وذ��/ Save /	ق ا(� ا�7'�? %@0 ذ�G اChange O3P ه�x ا�!

,01 (�_<� أن ./ 4�'> o
h2Dا� myweb ً'h· h2ذآ  .آ�

** ?�4
ت �>_
 ** 
�2ة E!0 آ�%? Index #,� أن #�	ن ا(� ا�7'�? ا�2\��5? -1D
 24�� =�> Gوذ� !E ./ G@�	
	ان 

 .ا���M'7 دون ا��-? إ�= آ�%? ا(� ه�x ا�7'�? 

� ا�2
	ز -2 $
ا��@2و/? وا��	-	دة /. �	<?  #,� أن �0d�5م ا��2وف ا�_��!�? ���%? ا(� ا�7'�? أو أي ر

?D#2� ز	
 . ا��'��M و+ �0d�5م <2وف 2E%�? أو ر
 

# +�� :+ ا�6K>� ؟؟؟ آ�a ;�>�ن �.�ر ��
4- ./ phزكأ 01,
 ./ G�'1
 �'�% p�� myweb xر5
ه�ا ا��5ر  c:\mydocument\myweb ا��ي 

0D�5�) _Fل MD7�) أي G@�	
 �)% www.des4arab.com ، �'!% ?�D;إ�= ا� G�'1
 و(�![� 

4زك - ./ 4D��2� ..�)
,B ���- <�/ �'�� 01	ر 
	�@G وه	 % G#0� phأ _ًF�/ images ..  م	]�) G���
h§%ر	و�&� /�> -��� ا�7 ?�D;ا� ./ G@�	
ء 
,01 %!'� ا+(� /. ;  ?
0d�5ا�� . ?D5!�% 
أ

41 وا��.�@% p�� .#� ا��	ت ا��'B �F

�0اد �1�1'ت ا`2Qى % $���� (htm.) ،  �5!0 وورد ، أو
أو 
01,
4زك /. - ./ 4�@Pو phT/ 
,myweb 01 ��2ه �
 إ�= -!� ًD!- images ..  G��� =إ� 41)2�)

01,
 �h,% ?�D;ا� images .. ¼ا ?µ�;�% ?�D;1= ا�E ت®Dا+ر� M�/ ./ آ�;
 . و%��G �� ��0ث 

+ ا
'�� ا��رس�Cا�  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ا�
رس ا����-
 

�'���/ �B ا��4اول # aآ�  ��� 	
  :2000:+ :�و
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اول �dام ا��6Jً* ا�6'اZوا *ً$ �E��IE� �"d* اآ�'  �6�45 ... }0 � J�� _ `6M� F� اولdا� ' g F$�  20*d(

 أو أو Jرأ �X _N��6ام  �[��. إ�- ... �5رة أو �N_ ��0ص �!^ �;� أ�$ة �d6*ورة أو J*( ���0 F�0

 *I0*+�45�6� وا 
اول �dا�!! 
2+3
ام ا�0
اول  #�
أ  :وا'ن ا

�� اVدوات ا�"!�ي'� 
ول �H ا��� �!^ ر�� ادراج ( � _Hو�^ راVا��`�ة ا 
6' �د ) 'ح ا�'��ز �Xوا
ه* �'� 
ة وا���4ف ا�6$�Vم أو. ا�6Jا insert>table  *�د �د ا��9Zو. 

ول ا�اX! 7 وا��*رH 7 )*رزة  �Z96J أن *dود ا�Z ..
ول ��7 4 �dود ا�Z �'� LEذا �� آ*$� (Preview) 
#M� 
رج �* (Normal) و�*ه'ة �� ؟؟ �!I"� ��*"6* و�'�  ...7` M( !! 

*IE� '6X7 ا$U*� �646J ا�4*رة F $�ول وا0+' dا� �X7 دا !X أي 
�646J �� 0*�[ة  Table Propeties �_ ا�$��' �

ول وه
 آ*�6*�dا� }U*�X ���� : 

 

	�P ا�,0ول /. ا�7'�?  :(1) 0#0���. 
(2):  #_dا� ��% ?/ .���0#0 ا��5
(3): G!��# ر�dه�ا ا� �
ء <0ود ا�,0ول /. ا���M'7 وذ�% G	G�) ?��� �P ا¦®ر 'Qا Border=0 ، 


� ه! G!��#ر  و .أ#&ً ز#دة (�G ا¦®
ر �	ن ا¦®ر <	ل :(4)��Q+  #_dا�. 
(5): Q+ 1'�? �0,1ولQ ن	ر ���. 
ر B	رة آ1d'�? �0,1ول  :(6)��Q+. 
ر 2Eض وار�'ع :(7)��Q+  ا�,0ول #_Q. 
(8): ���hdا� �
 ��D)!
 ��h	� ر��Q% Light border و Dark border  4hTا�,0ول وآ #_Q �@- G!�!�#
رزة % ..���- 24�
  . وه�ا (�@�4

7\r وQ �
 pµ� 
ر ��Q% ��O3Pا OK . 
** ?�>_
 ** 
( =1E �D�!�) ا�,0ول r\7Q �
 xر�d�) ر��Qا�,0ول أي ا #_Q ���- ) . 

=1E ?!�@
 r\7Q ��D�� أردت 	ذا �
 دون ا�D[�? ؟؟ ا`
O�5% 2 و��� #_dا� �
 ?E	�,
 �1Q? وا<0ة أو 
..!! 
1-  41Qا��2�² %0ا �P �1? وا<0ةd� ..0#0 ه���% �� #_Q و�@0ةx  #_dا�.  
2- 2�Qرة وا�1?  (��Cell Properties 24 اO3P #��� ا�'dا� r\7Q MP	� .ا�� ?�� :�G ا�!/�ة ا��
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ول  -3dا� }U*��( 7I �� *I0أ �Z9� �FاX.. آ$* �'� *� *IE� '6  *�9X ة أوZ7 وا !X ^!� *I+ �`6� }U*�X

دة (# ا����� OK . 
** 7�Z9� ** 

( 
اً � +"�ا�I* )};� أ��N ا�4Z ا��4�*ت ا�6^ �'ى  +"�اول وا�6"'ف إ�^ dا� #I4�  
� *I���$ $I* وا�6
 & ( L02000ا�4'و ) . 

  ا�c��C ا
'�� ا��رس
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4 ا�
رس ا��ا

 
# B� L'!A ��F� J.ّ�  ��� 	
  :2000:�و

 أ�?� �� <(=+� ؟ آ�: �49 78: أو6ً #
�X _��� ^7 اذه2 إ��
 ا��4� 
�;F ... ا��6'ا� I� J  7' �� ا��� )*�ادا�� Insert>Horizontal Line أ�+

 �'� *� 2MZ *ه'  �� �E;$� آ ~ ؟.. 
^!� 7Hا0+' 0+'ة ��دو �Vة ا�6*� 7 ا��� ا]�*Eا� �� 'I�6J *هE� 
+: 

 
(1) : Odل ا�	(2)   ® : G�) Od(3)   ا� : Odن ا�	�  

 
# �ً���@ :A��� �� <(=+� ؟ آ�: �
رج ر 

د آ� ' �F ا�'��ز  Insert>Symbol اذه2 إ�^ kدراج ر��� *I[ة )��646 0*J ..وا��� *IE� '6Xا Insert  #(
 . Close ا���

 

 
 ر��D أو �?�C �� <(=+� ؟ آ�: �49 ��
اد: @���ً� #

�'� $I* أو و�_ 0+*ط )I�0*d* ) ي �;� آ*L0  أي �'�د �F اJV`' و� �� �$*ذا �4"� ؟ ..�� آ*ن �
1-  
�'� $I* واH"� ا�60+*لاآ26 ا�M`�ر ا�6 �'� 76`Jا�( *IE ( Enter \ و� �+� Enter+Shift . 

�'� $I* واذه2 إ�^ �!� ا�M`�ر -2 �'� 
 Format>Bullest and Numbering ا�6�'� *� *IE� '6Xوا  #)
 أن ا�$*M�OK .. F ( 7 ا���d6J  �5 'ة L� . اJV`' أ�5

 

ÇáãÕãã ÇáÚÑÈí íÑÍÈ Èßã æíÑÌæ áßã ÇáÝÇÆÏÉ
 

# �ً��+=�ك �� <(=+� ؟ آ�: �
رج �E: را 
 :�646J �� ا�E*�[ة ا�Insert>Component>Marquee  7 �*6 اذه2 إ�^
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 .اآ�� ه! ا�!r ا����2ك  :(1)
(2): 2�� ?E2) r!ا� G#. 
 . h	ع ا��2آ? :(3)
 .�	�P �	ن �1d'�? ا�!r ا����2ك  :(4)

O3P2#0 �9 ا� 
 2�Qا OK ... �5� ./ <�!#@�% �� Preview . 
أ-1E .. �9 G�_#0@� 2= ا�!r ا����2ك (��24 ا�!/�ة ا�5%[?  �	 اردت �2��3 ا+0Eادات اh 2]h[2اً 
$دو-ً

O3Pا OK . 
 

# �ًG��ك ��رك ؟ ��� ه� �8 :�>�8Iا� 

 40\ ا��4�7 ؟ اI0* ه� s�J �� أن� F;و� 'Xu إ�^ �;*ن �!+E����N �!^ ار��*ط  *�E� _��� 5 7  زرت*X

�I!$� #6* ؟ �*)_ ا��`�ات ا� 7 �*6�IJ 7 !$"�*!7!! ا���ك �*رك  ~ ;� : 
1- ��� E� *I 6+� إ�E� ا��اU' أن �'� 
د ا�E{ أو ا���رة ا�6Z  F "� ط*�� .ار

 :ا��646J  7 �*6 ا�E*�[ة Insert>Bookmark اذه2 إ�^ -2

 
3- 70*X 
 . OK (# ا��� Bookmark name اآ26 اI� #J[ا ا�E{ أو ا���رة �

4- �'� 
د ا�E{ أو ا���رة ا�6Z^6+� إ�E � *I`�N� .هE*ك   ا��اU' أن 
 :ا��646J  7 �*6 ا�E*�[ة Insert>Hyperlink اذه2 إ�^ -5
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 /. ه�x ا�![�? ه�ا -$ء 
� ا�!/�ة /[O وه	!�4# 
 

��d( 7ار آ!$7ا��6 ا -6ME$7 ا�$U*+� Bookmark #Jأن ا� d6J  ا��`�ة 
 �# )*6X *ر�H��  Wد هE*) 3(ا�[ي آ�6�6 �
 . OK (# ا���


� �6('d6( #�  7E�ف أآ�' �F... ا�$"*Iط وا�*����N6 �� إ� إذا آ*L0 ا�$*M�F ( 7 ا�ر F� F;4*ع ا�}*�7  و�� 0ار

 
  ؟2000�ا�C3 ��و�� �� أزرار �+K��ة  آ�: �
رج: �3د3ً� #

 �'ور ا�4*رة �!^ زر ��6 ' ���0 أوE� _��� أن زرت �� s�J ؟  ه� ' ) �ث �� أي ��6�'ك أو � ... �$� �E;$�
& ( L0'و�7 `Jا�6 ( 'ات )�ا W]ه v"( 2000  
 :آ*�6*�

 ��Iر ا��ر � � -1�'� . �_ ا�$��' �
 ا�$;*ن ا�[ي 
 :ا��646J  7 �*6 ا�E*�[ة Insert>component>Hover Button اذه2 إ�^ -2

 
د ا�� *رات ا�6*� 7  -3Z: 

(1): W]ه 

 ا��ر  �� Wر�I� �'� .ا��*70 اآ26 ا�E{ ا�[ي 
(2): 7��6E+� ا��4 'Uا��ا �'� 
 ��� ا��ر ا�6E� *I إ� . 

 . ��ن ا��ر :(3)
 .�0ع ا�6 ( '  :(4)
 . �'ض ا��ر :(5)
 .ار�4*ع ا��ر  :(6)

ادات ا����kا ���  . Preview ا�6 ( ' �
 �M# ا�$"*�OK ، 7('d6( #� #) 7E و)"
** 7�Z9� ** 

�9ت ا�9ز�7ا0+' ا��ر 0+'اً ��دوHً* �!^ ا��ر �646J ا�E*�[ة ا�M �� اردت ��  ' ا��ادات] وا��� *)+6�*( #� #) 7"
OK]. 

  ا��ا�B ا
'�� ا��رس
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 M� ا�
رس ا��2
 

** p!ت إذا آ �D� =1E? ا¦ph2�h ، %> ا�@0#0 
� ا��1'ً�D5h ً2ا�Dآ ً@�	

�� #��1	ن   G
$1�/ ، ?E	!ا���
0@% ��/ G@�	
 ���45 إدارة ً���!� 2Fت أآ
,01ات /. 
	�@Gوذ�G . أن ��	ن ه�x ا��1' ��@%. 

## L�M�� +: ��4ات� /dت دا��-U�F هef ا��� U'= aآ� J<؟ و� 
1- ً�\_
 ً'�!7� G@�	
�>  G�1E أوً+ %�7!�¤ أ�5م #	����. 
2- =1E 0ل# 
,01 ��� ��5 و(�> %� ��@% �� Gت ه�ا ا�[�5  %@0 ذ�#	��
. 
ل  **F
 #&� ا`�5م ا�: ً@�	
 ��?�!'�2ض أن �#0!� : 
- o
�h?  ��5 %2ا,
. 

��B ?D	ر  -. 
-  ?�@�) ?D��
. 
-  .��1@� ���. 

ء أر%@?;h§% م	ز (![
,01ات /. ا�,4 01,
 ./  myweb  01,
ت 
	�@G ، و�5h. آ� '1�� .Pا+/�2ا
 #0ل�%  xا	��
 =1E ... .ا�	1= ا��E ?]% :/�Fً_ ��	ن أ(�ء ا`�5م ا�5

- software . 
- pictures 
- songs 
- edu 

ء ا�7'�ت (![	م;h0 إ!Eو  4� �)ء 
,B 01	ر %(�. %�'� آ� B'�? /. ا��,01 ا��!;hإ G!��#و " 
img " ، _ًF
  �5� ��% ?Bdر ا�	ا��,01ات ��'� ا�7 xه� �
  .دا�Q آ� 

!�ت و���ت اMI.�م  #A J�� �6<�ت� :,�/ اgر
رج/. ا�0Dا#? (��	ن ه!ك B'�? ر\��5?  -Q ��	�1� �) وB'�? ر\�index ، ?�5 ه�x ا��,01ات و%

index  01,
 . )��5 ( دا�Q آ� 
ت �4 و%��Tآ�0 (�;�2 إ�= أ�5م®Dار� �P	% ?�5�\2ا� ��	ا�� ?�'B ./ G@�	
 .... a�<:  ن�<';

  هef اgر��6<�ت ؟
ط إ�= : أوً+Dار� �P	� ، _ًF
 :ذ�G %§<0ى ®��]#2� edu  ��E G!��# ا�7'�? ا��5]� ?�5�\2 
h? )أQ ./ �.  ، URL �2��5 ا�@!	ان #0و#ً��   :%��C #�	ن آ

 
O3P �9 OK . م	]# 
0!Eو � M'7م ا���	ط (�[Dه�ا ا+ر� O3&% 2\2اءة ا�7'�? ا�2\��5?ا�$ا]% ً�\]1 index 

 . " edu " ��4ا ا�[�5
h? ا��1'ت )بQ �

,Create Hyberlink 01 /. ا(�@2اض ه�x ا�7'�?  M�'% م	]h C��% edu  2��Tوا��

?�'B =1E index �9 <1Q0ا% O3&h OK .  .�  :آ� /. ا�;�� ا��

 

 ً�h9: �dh U.M +: �!A J� �� U.M +: �! : ,�/ ار��6ط �"
ل  **F
: �5� ./ ?�'B !#0� software �)% internet.htm ، ?�'7� طDار� 4�/ �&h 2#0 أنh wall.htm 

�5� ./ pictures . 2® 0ى>§% Gذ� ��E G!��# ���]#: 
 :�2��5 ا�@!	ان #0و#ً  )أ

1- ?�'B M�/ا internet.htm  o�% phا�'2و ./. 
رة أو ا�7	رة ا��. �2#0ه أن ��	ن -2D@1= ا�E 2ط  ا�Dار�. 
/�ة -3h M�/ا Create Hyberlink . 
4- ?hQ ./ URL  .1# 
  :اآ�� 
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,2Q .!@� 01وج 
�/.. <�C أن  ** software ، ?�'7� ل	Bو ?�]Dوا� wall.htm . 
 . OK اO3P وأ2�Qاً -5
  )بً����
ل ا�@!	ان أ�	Qاد: 
1- ?�'B M�/ا internet.htm  o�% phا�'2و ./. 
2- =1E 2رة ا��.  ا�	رة أو ا�7D@ط ا�Dن ار�	أن ��  .�2#0ه
/�ة -3h M�/ا Create Hyberlink . 
4- 01,
 M�/1= اE`ا �
 pictures  <�#	��
 .+(�@2اض -��� 
5- ?�'B =1E 2أ� wall �9 O3Pا OK . 
ت %�� -��� **®Dار� ��E G!��# ?]#2ا�� x�4%و  G@�	
ت أ�5م '1
ت و�'B. 
ء 
,01ات ];h§% �� ً2ا�Qوأ  G@�	
ت آ� /. �'B �]hزك ، وا4- ./ 4 وأ(�ءهD��2� �'!% ?�D;ا� ./


19> /. ا�;�D? ��5 إ�= �# ] .  
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 ا�
رس ا��Gدس

 
��ذا ��*� ا�NOرات ؟ # 

' g �;{( F;6+!7 ، و�M� 7�45 ��$� *IE� م آ�*Mة أ��+M # ا��4�7 إ�^ � 
E"� .�Z9� �4�6 �!}�{ ا�$ 
��6 ' )�6 ' ا��4�*ت �
 ا� M*ر  و�_ :���  * � 76(*) F $ ا� 
� 7$U*�. 

*  7�Z9�: [ *I� ¯ن�آ$* أن �±°*رات � �ات  *I� �ا��6Jا E� *I�'"6J ويء*M� ] .  
�ا�C3 ا�(�و�� # ���D� QRDS �+رات ا��NOاع ا��� ه� أ�  ��  ؟2000

L0و'� �� '���  & (2000*H ة أ�;*ل�  *IE� �'��6ام �* Jا �E;$� .ه�ة �!4'�$*ت ، 
�E;$� :�}*هة ه[W ا�V;*ل آ*�6*�
  و

1- 7$U*� F� File '6Xا New #) Page . 
2- ^!�Vا F� '6Xار ، ا�Z _('� �64 J Frames . 

 
2  (��0E G� 24ة أ��ل -3��T��
2%� ا��	ار % �
4 /. ا�[�5 ا`#�� ا�1'5. �!#@
 G!��# ، ت�#2'1�


 =1E O3Pر ا��Q+2#0 ، و%@0 ا� OK . 
 .�ل ا��Fا�� Gوإ��:  

 
- ?�'B إذا أردت أن �!;.ء O3Pر ا . NewPage -0#0ة /. أي إ®
- ?�'B G#0� phه$ة و�2#0 ¡4	ره /. أ<0 ه�x ا¦®رات /O3P أ
 إذا آ- Set initial Page . 

**  .���7\r آ� إ®ر x0> =1E آQ 0#0��% �� G0 ذ�@%: 
7\7> اO3P %���� ا�'Tرة 1E= ا¦®ر-أQ 0#0�� 0#2� ا��ي . 


� ا�[\�? ا2�Q -ب Frame Properties . 
�G� 24 -ج�)  .���7\r ه�ا ا�'2#� آQ �%2
:  
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 .ا�'2#�  ا(� ه�ا -1
 . ا��. (�0ر-4 /. ه�ا ا�'E�#2!	ان ا�7'�?  -2
 .2Eض ه�ا ا�'�#2  -3
**  ?�>_
: x	;�# + .��  .� :��� ا¦®رات %�Q_ف د�? ا�@2ض ا��D ا��

إذا آph ا�[\�? /. ا��5ر وا�7'�? ا�O]/ . ?�5�\2 ، أ#�� وأ#25  آ� /. ا�;�� ا�5%� ه!ك ا®ران
 <�5 د�? ا�@2ض2E 0#0��%ض إ®ر ا�[\�? % /. ا����� /5![	مً�\]1� 2�3�# 2Q2ك ا�h�5 ، و�D� 

 M'7��1�. 
-  _ًF
:  ?�\ . Relative 1ا�2�h ?�5�\2آ>   %��5 ، و2Eض إ®ر ا�2E �@,h150?�'7ض ا�[

0
p إ®رات /. ا`1E= أو /. ا`('�  ار�'ع ا¦®ر ، وه�ا �� -4d�)إ+ إذا ا <-���. 

2%� ا� -5 �

	�@G أن�� %§زا�? ا¦�رة  M'7�# ��� 0#2� + p!رات  ����0 إذا آت ا¦®)]
 2�3#. 
ء <0ود آ� ا¦®رات  Frame Spacing اO3P ه�ا ا�$ر وا-@� ���? -6'Q¦ ، ً2ا'B. 
ر -7�dأن  ه�ا ا� C�> ?�]/`2®? ا���2#2 ا�2أ(�? وا�T% صQ: 

- If Needed :  <� ?- .¡4	ر ا�;E O#2!0 ا��
- Always : ر	2ار¡4��)% x . 
- Never :  ً�\4h xر	0م ¡4E. 

[ 2Qا�'2#� ا r\7Q 0#0�� G!��# ?]#2و%!'� ا�� ] .  

  ) :ا��=��ت ( :+ ا�"!�ت ا�'+ �.')�م اi<�رات  آ��� وB7 اgر��6<�ت ##

O3P /�> ا�E ?�'7!0  ا��ي (�'�M) ا�'E ) �#2!0 ا(�0dا
G ��2#[? ا¦®رات #,� G�1E ��0#0 ا¦®ر 
 .���ط 
 ، وذ�G آDار�: 

1- ?1E 2ط  أ�Dن ار�	أن �� رة أو ا�7	رة ا��. �2#0هD@ا�. 
/�ة -2h M�/ا Create Hyberlink . 
3- x0#2� ط ا��يDاآ�� ا+ر� ?hQ ./ URL .  

 
�G� 24 ا�;�� ا���. ، Target Frame ا1E =1E O3P= زر -4�) :  
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** M�/ ن�
ر ��Qا G!��# ?hdا� �
�'Tرة  (1) ا�7'�? % 2��T��رةأ. %D@ر ا���Qا �
h? و dا� �
 ?D) ا��!

(2) ،  C�>: 
Page Default [main : =�5ا�� .Pر ا+/�2ا . M�'� main ا�7'�? /. ا¦®

Same Frame :  ر ./�h ./ M'� ا¦®
Whole Page ,Parent Frame :  �

M�/ ) ?1 /. إ®ر آ ) .B'�? آ

New Window : ة�/h ./ M�/  =]D� C��% ، 0#0ة- ?>	�'
 .ا�7'�? ا`و�= 
  . OK اO3P وأ2�Qاً -5
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 4�Gرس ا�
 ا�
 

 gًأو :����N�: +؟ ��ه+ ا�-��ذج ؟ و�� ه 

� ا��[	ل ?E	�,
 �E رةDE .ذج ه4 O3&# �9 زر  ا�!�!
 0#2# 
ر ��Qوا ?µD@�% 2\م ا�$ا	رات #[��Q+وا

�2ة ���24 ا�!� ( Submit ) ار(لD

	�@G أو �2D� �)2#0ك  ./ ?�'B ./ ?,�.  

 �ً�
 :������ت ��ل ا�-��ج : \�
 . <FORM/> و#!�% .4	0D# <FORM> �)أ ا�!�	ذج %	(� -
- ?%�h ذج	م %§دارة ا�!�	]# �F
 ph2�h¦ت ا
��	ب %§<0ى �3 o
h2% G!E perl ، php ، asp . 

o ا��ي �O%2 %> ه�ا ا�!�	ذج %;����. #@�� ا�!�	ذج /. 
	�@G #,� أن #@�� ا� -h2D  ��1) . وه�ا

o
h2D��3 ه�ا ا�;� G@�	�� ¤�&�5ا�2/2�5 ا�� �E0# �1 أن��# . 
- ?/2@
 G#0� ن	أن #� �,# G@�	
ء �h	ذج /. ;h0ء /. إDا� �D�  ، o
و�	 %��5? %�2#[? �2آ�� ه�x ا�2Dا

ل 1E= �2آ��F
  . " Cgi " �	ب %31? ا�5. -. ·يأ<0ه وه	 
� وا��. (!�آ2 /. ه�ا ا�0رس 

 �ًC��\ :رات ا��.')��� :+ ا�-��ذج��'dgل وا��!��� a=��'ا� : 
�% G��'B ./ ذج	�h دراج¦ ?�\ت ، اذه� إ�= �hQ �
 <#	��# Insert =1E 2�9 أ� Form ،  G� M�'�)


 4% ?�\�  .1#: 

Uــــــ;gح ا�Kا� 

Form ?]�!
 ) /[1E O= زر#� ، أ<0ه� �_ر(ل�h	ذج /. ا�7'�? ���	ي  #0رج 
Submit )  M5�1� 2Qوا) Reset ) . 

On-Line Text Box �%2
 .rh %2�5 وا<0  #0رج 
Scrolling Text Box �%2

�@0د ا`(�O#2� <% ، 2 ��2#2  #0رج  rh. 

Check Box �%2
4  #0رج !

� وا<0  2Fر أآ��Q1$ا\2 ا� ����0 #���. 
Radio Button 0رج زر# �Qا O]/ 0>إ+ وا 4!
ر �d# ����5 ا�$ا\2 أن# + C��% ، ر�. 

Drop-Down Menu 2ة  ¦دراج�Fرات ا����Q_� ?D)!

!Ò� ?�05('� ، وه.  ?�\�. 
Push Button رغ... ا`زرار  ¦دراج
� ا�'	رم ا�' ً�\`زرار (�0رج �1[/ <-��� + . 

Picture رة	B 0رج# 
4 %0ل ا�$ر #��!G ا(�0dا.  

�Kء :�رم ��=�ي :+ ��L�M: را��ً� i ل�C� : 
�'	رم ا�2D#0ي ؟ **% .!@h ذا
 

?�
	�@G دون  ا�'	رم ا�2D#0ي ه	 �h	ذج #����5 ا�$ا\2 
� Q_�> أن G� �)2# ر( �
�2ة D
�2D#0ك 
4�1 1E= ا�$ا\�E 2 وه	 آ� �_<� #�45... ا��-? +(�0dام x0#2% �_ر(ل E <@,;#ل و .�1? ا+ر(

ء ه�ا ا�'	رم ##;hإ ً@
 :�Q	ة �Q	ة  وان �!0Dأ 
 :#����5 ا�$ا\2 أن  
� Q_ل ه�ا ا�'	رم

 .G� �)2# ا(�> ا��[�[. أو ا���5@ر  -
-  <�1E ا�2د �
 ����1� .hا¦���2و x0#2% 0رج#. 
��>  #�0د E!	ان -)2�. 
-  0#2#  .#��� ر(�? �G آ�
 :ــــــــ�ات ا�)?ـــ *
1- ?�\� M�/ا Insert 21= وأ�E Form 4!
 2�Qا ، ?�\� M�'�) Form . 


�[�� %> زران ، أ<0ه� آ� �_<� �� إدراج 
����5 %�0 أ(	د Submit 2Qل وا�Reset  M5�1 �_ر(
 0#0- �
 ?% .ه	 ا�'	رم و��!> + #$ال /رغ  ه�ا.وا���

* 2��3�� Submit و Reset =1= زرار( إ�E ?-دو$
ل و
1E M5= ا��	ا�. ، اh 2]h[2ة  Submit  x0ل ه�D�)وا
 .إ�= 
Reset  M5 ار(ل ، و%!'� ا��2#[? ��2 ا���1? %ـ

 .ا��2�² دا�Q ا�'	رم وادرج -0ول %Tر%@? B'	ف و�E	د#�  ا�2ك -2

� أ1E= `('�  اآ�� /. -3 ���2�� :ا�@�	د ا`#�� %
 : ا+(ــــ� -
 :¦���2وE .h!	ان %2#0ك ا -
-  G�� :E!	ان ر(
- G�� : اآ�� ر(

�.  /. ا��1d? ا`و�= 
� ا�@�	د ا`#25 أدرج 
rh �%2 و<�0 ا�2�5 -4�� :آ
Insert>Form>On-Line Text Box  

?hQ ./دو-? ، و$
 . OK �9 اname O3P اآ�� Name �9 اh <�1E 2]h[2ة 
5- ./ �h? آ�F�1? ا�dا� ./ � �
h?ا��1d? ا`و�= Q ./ �)+2��3 ا Name =إ� email . 
رات �@!	ان -6�Q 0ةE 4% ?�05!
 ?�\� ¤Pأ ?F�F�1? ا�dا� ./  .��� :ا�2(�? وذ�G آ

Insert>Form>Drop-Down Menu  
?hQ ./دو-? و$
�.  OK و��D أن �&subject ، O3 اآ�� Name �9 اh <�1E 2]h[2ة ��رات ا�@!	ان آ�Q 0د>

: 
Add ?h = زرا1E O3P -أQ ./و Choice  اآ�� " G�� . OK �9 اO3P" اE 2�Q!	ان �2(
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2ة أ2Qى اO3P -ب Add ?hQ ./ واآ�� Choice O3P�9 ا ?µ!42 و��� OK . 
 Drop-Down Menu ¦�_ق 
2%� <	ار OK و%!'� ا��2#[? أP¤ -��� ا�@!و#� ا��. �2#0ه ، �9 اO3P -ج

Properties . 
7- ?�1dا�2ا%@ /. ا� .���
�h rh �%2@0د ا`(�2 آ ¤Pأ ?: 

Insert>Form>Scrolling Text Box  
?hQ ./دو-? و$
  . Ok �9 اmassage O3P اآ�� Name �9 اh <�1E 2]h[2ة 

 �ً.��d : ا ا�-��ذجfأداء ه �=�?� : )ا��رم ا�6�=�ي ( 
 (!;2ح **Q 2ك�# ��� T�Q ?�'B #2(� %2#0 و �2 ���� ?�'B r7dh ¤آ� ت 
�1	%? وذ�Gه!h 

 .��� :آ
%	ا(�? ا�'2وerror.htm  o�% ph وأ2Qى T�Q و���� ا(�4 B ��B thanks.htm'�? ��2 و���� ا(�4 -أ

?�D;ا� ./ G@�	�� رات وار(41DE �
 0#2� 
  . واآ�� /�4
ص %�� 
� B'�? ا�;�2 وا�T�d وا��ي (�0رج /�> -بdد ا�	ا�� �P / G@�	
. E!	ان ا�7'���� /. 

.��� : ا�;�D? وذ�G %	ا(�? ا�'2وo�% ph آ
/? B'�? ا�;�2 -1Pإ thanks.htm : 
 . Form Properties دا�Q ا�'	رم واO3P %���� ا�'Tرة وا�P 2�Q ا��2�² -

Advanced  0#0- �%2 ا1E O3P= زر - G� M�'�) �')`ا ./. 
redirect ?h واآ�� Add ا1E O3P= زر -Q ./ Name ،  ./ �9 اآ��?hQ Value ان	!E  ./ 2�;ا� ?�'B

�F
 G@�	
 http://www.des4arab.com/thanks.htm O3Pوا OK . 
2- T�dا� ?�'B ?/Pإ error.htm : 

O3Pا ?]%missing_fields_redirect ./ ?h واآ�� Add %!'� ا��2#[? ا�5Q Name ،  ?�'B ان	!E �9 اآ��
 �%5�
	�@G آ ./ T�dا�. 

*  ?�تو��. ��24 ر(hd0 �2ك ا�!E T�dا�  .� :ا�&2ور#? �� %
- 2�Qرة واT'ا� ����% O3Pرم وا	ا�' �Qا��2�² دا �P Form Properties . 

2%� -0#0  /. ا`('� Advanced ا1E O3P= زر - G� M�'�). 
required ?h واآ�� Add ا1E O3P= زر -Q ./ Name ، ?hQ ./ �9 اآ�� Value تhdء ا� ا��. �2ى أ(�

�F
 ?1B'% ?�	7'
   .9_ث 
2ات  OK ا2P name,email �9 O3Pورة 
Òه

�!�=/ ا��;�N/ ,�� ��=�ك ا�)�ص ور�& ا��رم ا�6�=�ي: ;�د;ً�  ���
�6���: 
ع ا���.  #,� آ�%? E!	ان ا�2D#0 ا��ي �2#0 أن ��D]�5 -أD�% Gوذ� �\ :�1E> ا�2(
 . T Form Propertiesرة وا�P2�Q ا��2�² دا�Q ا�'	رم واO3P %���� ا�' -

Advanced 0#0- �%2 ا1E O3P= زر - G� M�'�) �')`ا ./ . 
recipient ?h واآ�� Add ا1E O3P= زر -Q ./ Name ، ./ �9 اآ�� ?hQ Value  .h2#0 ا¦���2وDان ا�	!E

�F
 webmaster@des4arab.com O3P�9 ا OK 2ات  9_ث
. 
 /. #,� أن �O%2 ه�ا ا�'	رم %2D -بh2ذآ 
o آ�h"  ً�h0
> ه! ا(�>" 9d�5!) ا��ي o
h2Dوا� 

FormMail.cgi �Q01 و(!&@> دا,
 cgi-bin O%2م %@��1? ا�	و(![ ، ?�D;/. ا� ��	ا�� ./  .��� :آ
- 2�Qرة واT'ا� ����% O3Pرم وا	ا�' �Qا��2�² دا �P Form Properties . 
ر -��Q+2%� ا
 =1E 2أ� Send to other �
ر ا`ول /. ا�[\�? ا��!�05? %,Dh>  و�Tآ0 �dر ا���Qا. 

Options  0#0- �%2 ا1E O3P= زر - M�'�) �')`ا ./. 
- ?hQ ./ اآ�� Action ان	!E �F
 G@�	
 ./ o
h2Dا� http://www.des4arab.com/cgi-bin/FormMail.cgi 

O3P�9 ا OK  ���2
.  

 �ً���; :�M�� +: ���
6>���آ�o ا�6�Kا� +: L : 
1- o
h2D1= ا�E �7>ا �&O3 ه!% 

o وا/��> /. ا�2�/0 ا��2/� %	#!0وز -2h2Dا� O3P G/ "WordPad" . 
3- 2�� des4arab.com =إ�  G@�	

�2رة 
��2� E )!	ان  4hأ �>+. ( 
 . Text Document ا��µ�4% 2��3? ا<'� -4
 -501,

o إ�= h2Dأر(� ا� bin-cgi ?�)ا	% G@�	
 ./ o
h2% FTP ?µ�4% .. ASCII  o
h2Dأ('� ا� �


?µ�4ا� x0#0 ه��� G!��# .  


2Dوك �[0 اG#0� MDB /	رم %2#0ي . ...%�,4�%2  وأ2�Qاً أر(� ا�7'�? ا��. 4% ا�'	رم ا�2D#0ي ��	�@G و��
 G@!B �
ص %�	�@G وQ.  
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